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1 Scope and Purpose

This document describes how to use the dtdisplay module of d*TREK. dtdisplay
displays d*TREK compatible images on a color X Windows display. Since
d*TREK images usually depict single crystal diffraction data, dtdisplay has a
variety of features that help analyze images within the context of a single crystal
diffraction experiment.

With dtdisplay users can:

+ Display d*TREK images in any of eight orientations with a variety of color
scales,

e Zoom, Pan, and Resize the image display,

 Pick spots and display pixel value, resolution, integrated intensity, and
background average,

« Measure the d-spacing between selected spots,

» Display saturated pixels in selected colors.

« Display image headers,

» Plot reflection lists in selected colors,

« Tile a series of images to create a new image,

« Overlay a series of images to create a new image,

« Display images with non-square pixels in true aspect ratio,

« Display images as they are collected by dtcollect .

As time progresses, additional features will be incorporated into dtdisplay.

In order to perform certain calculations (e.g. resolution), dtdisplay requires
knowledge of the source, the detector and the detector goniometer. dtdisplay
gleans all this information from the header of an image file, so that additional
input is usually not required.

Definitions of an image and a scan are found in the Appendix.

2 Background

When you collect and process single crystal diffraction images from a position-
sensitive detector, it is very useful to visualize or see the images. You want to
check that the crystal diffracts and that the Bragg peaks can be integrated. The
suitability of a crystal for further data collection and analysis depends on a
number of factors and compromises. Among these factors are:
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« crystal unit cell

» spot shape (no split or satellite peaks)
 diffraction limit

e spot separation

e exposure time

e rotation angle increment

e detector position

For example, if the unit cell lengths are large, then the diffraction spots will be
spaced close together and the detector will have to be moved further from the
crystal. Often only by viewing images can you judge whether or not you should
collect diffraction data from a crystal. The dtdisplay program displays images
and allows you to decide whether to proceed.

dtdisplay uses a color X Window display and the OSF/Motif widget set and style.
Both X and OSF/Motif are widely used on workstations, so you may already by
familiar with them and consequently already know how to run and use dtdisplay.
If you are not familiar, do not worry as dtdisplay is very easy to use and comes
with many help features. Before you start dtdisplay be sure your DISPLAY
environment variable is set to your current display and the Dtdisplay application
defaults file is accessible to your X server. The latter file can be placed in the
system-wide application defaults directory (e.g. /usr/lib/X11/app-defaults) Or in your
home directory. Please consult the installation guide in section 5 and your
system manager.

3 Running dtdisplay

After dtdisplay has been installed and placed in your PATH, to run it just enter
dtdisplay along with an optional image filename. Since dtdisplay is an X Window
program the standard X command line options are also supported. Messages
are written to stdout and stderr as required. The syntax for running dtdisplay is
simply:

dtdisplay [image_file]
Remember, the image filename after the dtdisplay command is optional.

The dtdisplay main window shown below in Figure 1 will appear on the display.
The main features of the window are a title, a menu bar with some command
buttons, a scrolled text output region, text fields to enter the detector position,
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and two areas for image displays. Each of these features is discussed is
following sections.

Figure 1. dtdisplay main window before loading an image file.

Getting help

The main window title is usually supplied by the window manager. dtdisplay
changes the title in response to user input in two ways. First, when an image is
displayed, the title is changed to show the name of the image. Second, when
the mouse is used to “arm” a button, the title is changed to show what that
button does. In this way, you can receive continuous context-sensitive help. If
you ever have a question about what a button does, move the mouse pointer
over the button, then press and hold down the mouse button. The title will show
what the function of the button is. To activate the function, simply release the
mouse button. Do not release the mouse button with the pointer in the button
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unless you want to activate the function. To avoid activating the function, move
the mouse pointer off the button, then release the mouse button. More
extensive help can be viewed by selecting the HTML Help Viewer command
from the Help menu.

3.1 Menu bar

The menu bar has File, Edit, View , Option and Help menus. If you move the
pointer over one of the menus, then press and hold down the left mouse button,
a pulldown menu appears with further commands. Drag the mouse pointer
down over the desired command (look at the context-sensitive help text in the
main window title) and release the mouse button to select the command.

3.1.1 File menu

The File menu is used to create new images, to open existing images and to
load reflection lists that are displayed. New images that are created can also be
saved to disk files. The commands in the file menu are New, Open, Save As,
Image Template, Preferences, Print and Exit. Many of these use the image file
and template selection dialog shown next.

Figure 2. Image file and template selection dialog.

The image file and template selection dialog is a standard Motif file selection
dialog with three additional controls for sequence start, sequence increment and
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number of images. In order to specify a range of images, the Filter or Template
field is combined with the sequence start and increment fields to yield complete
filenames. Any question mark characters (?) are replaced with the sequence
number to get a filename. For example, if the Template is image.??? the Seq start
is 1 and the Seq incr is 1, then the first image filename is image.001, the next is
image.002, and so on.

Here are specific directions on each of the commands in the File menu:
New

The New command popups a menu with the following choices:
* Image File...

e Scan...

e Overlay...

* Average...

o Tile...

« Statistics...
Image file...

When this is activated, the image file selection dialog appears. Select an
image file from the list of files and then select OK. The file will be read in,
automatically scaled to the color table and displayed.

Scan
This command is not yet implemented, therefore it is insensitive and
cannot be selected.

Overlay

Overlay creates a new image by overlaying a series of images and
displays the resulting image. The image can be saved to disk by selecting the
File Save As... command. To use this command, first read in and display an
image with either the File Open... or File New Image File... commands. Then
select File New Overlay... . The image file and template selection dialog
appears (see Figure 2). Enter the sequence number start, the sequence number
increment, the number of images to overlay and the image filename template,
then select OK, overlay . The image filenames will be constructed from the
template and a sequence number by replacing the question marks (?) in the
template with the sequence number. For example, an image template
ribosome.???? might represent the files ribosome.0001, ribosome.0002, etc.
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When images are overlaid, the highest pixel value in any input image for a given
position is placed in the created image. For example, if you have three 2x2
images with pixel values:

12 23 4 3

34 41 21
the overlay result image will be:

4 3

4 4

The overlay command is useful to create pseudo rotation images that span a
larger volume of reciprocal space.

If an error occurs while reading in an image, then the overlaying stops and the
overlaid image in its current state is displayed. Use File Save As... to save the
overlay image to disk.

Average

Average is similar to the overlay command and works the same way.
Instead of selecting the highest pixel value for the output image, the average
value is calculated. In addition, an image of standard deviations is calculated
and written to the file named by the first image used in the averaging with the
characters 'sd' appended. Use File Save As... to save the average image to
disk.

Tile

Tile creates a new image by tiling a series of images and displays the
resulting image. The image can be saved to disk by selecting the File Save
As... command. To use this command, first read in and display an image with
either the File Open... or File New Image File... commands. Then select File
New Tile.... The image file and template selection dialog appears (see Figure 2
above). Enter the sequence number start, the sequence number increment, the
number of images to overlay and the image filename template, then select OK,
tile. The image filenames will be constructed from the template and a sequence
number by replacing the question marks (?) in the template with the sequence
number.

The tiled image has the same dimensions and data type as the input images. In
order to achieve this, some pixels in the input images are skipped over. Zooming
in on a displayed tiled image does not recover the pixels skipped over. The
number of rows and columns in the output image is a function of the number of
images. For example, if 4 images are tiled, then the tiled image will be 2x2. If 6
images are tile, then the tiled image will be 2 x 3 with gaps along each row. To
avoid gaps, choose a number of images that is the square of an integer (namely,
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4, 9, 16, 25, ...). Furthermore, the first image is placed at position (0, 0) while
the next image is adjacent to the first image on the same row. Rows run along
the FAST pixel direction while columns run down the SLOW pixel direction. In
the display, the FAST and SLOW directions may have a non-standard
orientation (see Orientation in section 3.1.2.1).

If an error occurs while reading in an image, then the tiling stops and the tiled
image in its current state is displayed.

Statistics

When implemented, Statistics will statistically analyze an image or a
series of images. For now, to average images and compute a pixel by pixel
standard deviation, use the Average command.

Open...

The File Open... command selects an image file to display. When this is
activated, the image file selection dialog appears. Select an image file from the
list and then select OK, Open. The file will be read in, automatically scaled to
the color table and displayed.

Load refinlist

The File Load reflnlist... command selects a reflection list to display.
When this is activated, a file selection dialog box appears. Select a reflection list
file from the list and then select OK. The file will be read in and displayed. If
reflections are not displayed, check that Observed reflns is set in the View
menu. Check also that the reflection list contains the fields fobs_pixel0 and
fObs_pixell, Or fCalc_pixel0 and fCalc_pixell.

The properties of the reflection list display can be edited by selecting Edit
reflection properties... in the Edit menu (see 3.1.2).

Save As...

This command saves the currently displayed image to a file. If there is no
currently displayed image, then this command does nothing. The image file
selection dialog appears which allows you to enter a filename for the new image.
If you select a filename that already exists, the new image will overwrite the file
unless the old file is write protected.

Image template...

This command lets you view and edit the current settings for the image
filename template and sequence numbers. An image template dialog box
appears as shown in Figure 2 above. The settings in the dialog box come from
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the header of the last image read in or from the last time the image template
dialog appeared. Remember that Overlay , Average, Tile and Statistics in the
File New menu all use the image file and template selection dialog.

Exit
This command exits from dtdisplay.

3.1.2 Edit menu

The edit menu has commands to display dialog boxes that let you edit the way
images and reflections are displayed.

3.1.2.1 Image view properties dialog

Choose Image View Props... in the Edit menu to display a dialog box with the
current image view properties as shown in Figure 3. The view properties include
Integration box size, Saturated pixel cutoff, Saturated pixel color, White pixel in
image, Black pixel in image, Image border fraction, Orientation, Preserve aspect
ratio, and Pixel aspect ratio. In all cases the values set in this dialog do not take
effect until either the OK or Apply button is selected. Also, if no image is
currently displayed, then settings made in this dialog box have no effect.
Selecting Help activates the HTML viewer for on-line help.
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Figure 3. Image view properties dialog.

The dialog box has two halves -- a left one and a right one. To view the full
dialog box, select the small arrow button below the Image border fraction field.
To return to view to the left half, select the arrow button again. The top portion
of the dialog shows static image properties calculated from the pixel values in
the image itself. The lower portion shows the properties that you can change
which will affect the displayed image.

STATIC IMAGE PROPERTIES

Image size
The number of pixels in the fast and slow directions in the image.

Min, max
These are the minimum and maximum pixel values in the image exluding
a border of 10% around all 4 sides.

Average, sd
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These are the pixel value average and standard deviation calculated from
the image excluding a border of 10% around all 4 sides.

Rot start
This is the relative rotation angle start from the image header.

Rot end
This is the relative rotation angle end from the image header

Exposure time
This is the image exposure time in seconds from the image header.

ADJUSTABLE IMAGE PROPERTIES

Integration Box Size

Enter the integrate box size in pixels in the FAST and SLOW image
directions separated by a comma (,). When a pixel is selected in the image
display area, then the pixels in an area /, by / are integrated. First an average
and standard deviation is computed, then after excluding pixels with a value
3sigma above that average a new average and standard deviation is computed.
Then all the pixels in the area are summed and the average pixel value times the
number of pixels is subtracted. This gives a rough estimate of the integrated
intensity of a picked Bragg reflection. If the non-uniformity information is
available, then the area is corrected for non-uniformity first. If the Integrate Box
Size is less than 2 x 2, then a default value of 24 x 24 is used. No effort is made
to exclude neighboring spots from the integrate box when the calculations are
made.

This box size is also used to set the size of the small zoomed image in the
lower left of the main dtdisplay window. The box size is local only to dtdisplay.
It does not affect the box size in dtintegrate or dtfind .

Saturated Pixel Value
Enter the minimum value of a saturated pixel. All pixel values that are
greater than this value will be displayed in the Saturated Pixel Color.

Saturated Pixel Color
Select the color used to display saturated pixels from the combo box. A
limited number of colors is available.

White pixel in image (Minimum scale value)
Pixel values below this threshold are all set to white. This value may also
be changed through the color scale below the image.
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Black pixel inimage (Maximum scale value)
Pixel values above this threshold are all set to black. This value may also
be changed through the color scale below the image.

NOTE on color scale mapping:

If the White pixel value is more than the Black pixel value, then the color
scaling is reversed. Thus, if these values are 10 and 5000, then the color
mapping runs from white (low) to black (high). If these values are 5000 and 10,
then the color mapping runs from white (high) to black (low) which reverses the
color mapping.

The starting values for the white and black thresholds are set automatically
whenever a image is read in with the Open command in the File menu. The
average and standard deviation of all pixels except a border of 10% along the
four edges is calculated. The white threshold is set to the average - 1.5 *
standard deviation. The black threshold is set to the average + 5.0 * standard
deviation.

The color scale is most easily changed by directly manipulating the minimum
and maximum scale values on a color scale which appears below the large
image display area. If the Image border fraction is less than 1, then a color scale
control pops-up when the left mouse button is pressed when the cursor is in the
line profile area along the bottom of the image area. You can change the
minimum scale value or the maximum scale value by grabbing the end of the
arrow and moving it left or right. Values for the displayed image are updated
only when the left mouse button is released in the bottom line profile area. To
cancel any impending changes, move the cursor outside of the bottom line
profile area and release the left mouse button. The color scale has marks for 3
values: the image average is a solid vertical line, 1.5 sigma below the average is
an ascending half line to the left of the average (it may be off scale), 5 sigma
above the average is a descending half line to the right of the average (it may be
off scale).
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Figure 4. E xample of color scale control.

Image border fraction

If this is less than 1, a border is reserved on the right and bottom sides of
the image display area for drawing line profiles. A value of 0.9 results in the
image area occupying 90% of the drawing area with the line profiles occupying
strips of 10% on the right and bottom sides.
Resource file default: *culimageviewprops*tfBorder.value: 0.9

Orientation

A combo box is used to select one of eight possible orientations for the
image display. The choices show how the image FAST and SLOW pixel
directions should be mapped to the X Window coordinate system X and Y. X
runs across the display while Y runs down the display. Do not confuse the X
Window display XY coordinates with the laboratory XY coordinates. The
selected orientation is applied only after selecting the OK or Apply button.
Resource file default: *culimageviewprops*omOrient*labelString: +X +Y

Preserve aspect ratio

Select whether the Pixel Aspect Ratio will be preserved when displaying
images. This is useful when you want to preserve the image aspect ratio when
you resize the image display area.

Pixel aspect ratio

Enter the pixel size aspect ratio. The ratio is the size of the pixel in the
FAST direction divided by the size of the pixel in the SLOW direction: FAST /
SLOW. For example, if the detector pixels are 1.28 mm by 2.00 mm, then enter
0.64 for the aspect ratio.

Auto rescale
This is reserved for future use and has no effect now.

Reserved
This is reserved for future use and has no effect now.
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3.1.2.2 Reflection view properties dialog

Choose Refln View Props... in the Edit menu to display a dialog box with the
current reflection view properties as shown in Figure 4. This dialog box is not
active yet. The view properties include Symbol, Size, Color, Visibility, Restrict,
and Rotation range. In most cases the values set in this dialog do not take effect
until either the OK or Apply button is selected. Also, if no image is currently
displayed, then settings made in this dialog box have no effect. Selecting Help
activates the HTML viewer for on-line help.

Figure 5. Reflection view properties dialog.

Reflection list
This shows the file name of the reflection list. Use File Load refln list...
to load the reflection list.
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Symbol

Select the symbol used to draw reflections with. You can choose a plus
sign, an X (cross), a circle or a box. Only a plus sign is supported now!

Size
Enter the size of the symbol in pixels. The size is fixed at 20!

Color
Select the color of the symbol. The default color is set by the refinPlotColor
resource (see section 5.2).

Visibility
Select whether this reflection list will be plotted (visible) or not.

Restrict rotation range
Select whether all reflections in a list should be plotted or whether only
reflections that fall with a restricted rotation range.

Rotation range
Enter if the restricted range for reflections to be plotted. This range is only
used if Restrict rotation range is in effect.

Clear selected output

When this command is activated, any selected text in the scrolled text
output window is deleted. Text is selected in the normal Motif style: double-,
triple- or quadruple-clicking the mouse button, dragging the mouse pointer while
holding down the shift key, etc.

3.1.3 View menu

Commands in the View menu are quick ways to change what is viewed in the
image display area.

Refresh
This refreshes the image display area by remapping from image pixel
values to the color scale and displaying the result.

Zoom...
This does no zooming, but pops up a message box describing how to
zoom by dragging out a zoom box with the middle mouse button. The message
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box serves as a reminder of the not-so-apparent function of the middle mouse
button. NOTE: Make sure the CAPS LOCK, SHIFT and CTRL keys are not
depressed or you will be unable to drag out a zoom box.

Unzoom

This unzooms a zoomed image and refreshes an unzoomed image. You
can also unzoom an image by double-clicking on it with the middle mouse
button.

Pan...

This does no panning, but pops up a message box describing how to pan
by dragging the cursor with both the left AND middle mouse button pressed..
The message box serves as a reminder of the not-so-apparent function of the
mouse buttons.

Rescale

This is not implemented. This should recalculate a default color scale by
computing the average and standard deviation of pixels in the image and scaling
them to a gray scale. See section 3.1.2.1 Note on color mapping for more
information.

Image header...
This displays a new window with the image header in it. You cannot save
any edits made to the image header.

Calculated reflections
Observed reflections

These toggle buttons select whether any available reflection list is
displayed or not. Only Observed works for now.

Resolution arcs

This draws up to 5 iso or constant resolution arcs on the main displayed
image. To determine the resolution of any given arc, simply click on it and view
the resolution in the scrolled text output in the upper left of the main window.

Measure

This selects whether the crystallographic d-spacing in Angstroms between
the last two selected pixels is calculated and displayed in the scrolled text output
area. The detector position and spatial distortion as well as the source
wavelength are required to calculate the d-spacing. If they are unavailable, then
the d-spacing is not calculated. Shortcut: You may also use Shift-Middle
mouse button to measure the d-spacing between any two points.
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3.1.4 Option menu

The Option menu provides a way to easily add extensions to the dtdisplay
program. Presently, no extensions are implemented.

Perspective
This creates a separate window with a perspective or mesh plot of the
currently displayed image area. Not yet implemented.

Contour
This creates a separate window with a contour plot of the currently
displayed image area. Not yet implemented.

3.1.5 Help menu

This help menu provides access to the hyper-text markup language viewer.
Context-sensitive help is provided in the main window title whenever a button is
armed. (In Motif version 1.2, the title will also provided help on text fields when
they gain keyboard focus.)

Help via the HTML viewer

Select this command to activate a hyper-text markup language (HTML)
viewer to view the dtdisplay HTML help files. The default HTML viewer is NCSA
Mosaic, but this may be changed in the resource file. If the viewer is already
running in the process tree, then it is used, otherwise a new process is created
that runs the viewer.
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3.2 Main window controls

Along the left side of the main window below the menu bar is a control panel.
The panel contains a scrolled text output area, text fields to change the detector
position and wavelength and buttons to move to the next or previous image in a
scan.

| N e
s gl i,

N
I\ F LY

Figure 6. dtdisplay main window. Note scrolled text area and other controls on left.

Scrolled Text Output

The scrolled text output is a flexible way to provide information about
points selected in the large image display area. When you select pixels in the
large image area, the information in the scrolled text area usually contains:

Pixel position

Pixel value

Millimeter position
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Resolution

Integrated intensity and standard deviation
Average background and standard deviation

If the Measure toggle button in the View menu is set, then the crystallographic
d-spacing between the selected pixel and the previously selected pixel will be
reported. The information reported does depend on a number of factors. The
millimeter position, resolution and d-spacing all depend on knowledge of the
detector position, the detector spatial distortion and the source wavelength. |If
this additional information is unavailable, then millimeter position, resolution and
d-spacing will not be reported.

Shortcut:  You may also use Shift-Middle mouse button to measure the d-
spacing between any two points.

Use the scroll bar to scroll the output backwards and forwards. The output may
be cleared by first selecting it and then choosing the Clear selected output
command from the Edit menu.

Rot. start, Rot. end
Enter the rotation start angle and end angle for the image. Presently,
these have no effect.

Det swing

Enter the desired detector swing angle in degrees. The direction of the
swing axis is specified in the header and is usually the theta or 2theta value of
the detector. Use this command to check the resolution limits at a particular
detector position. The starting value for the swing angle is read from the image
header. The value is updated only after a carriage return or when the text field
loses input focus. See Note under Wavelength below.

Det dist

Enter the desired detector to sample distance in millimeters. Use this
command to check the resolution limits at a particular detector position. The
starting value for the distance is read from the image header. The value is
updated only after a carriage return or when the text field loses the input focus.
See Note under Wavelength below.

Wavelength
Enter the source wavelength in Angstroms. This affects the calculation of
resolution only.
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Note: When the detector distance or swing angle or the source wavelength is
changed, then the minimum and maximum resolution available on the detector is
displayed in the scrolled text output in the upper left of the main window.

Prev, Next, No.

These commands let you easily select the previous image, the next image
or a specific image sequence number in a scan to read in and view. If a scan
definition is not found in the image header, then these commands should be
insensitive.  You may specify your own scan definition with the Image
template... command in the File menu. When an image is read with the Prev,
Next or No. commands, the mapping of pixel values to colors is not changed, but
the current mapping is used. If an error occurs when reading the image file, then
the image display areas go blank. No. uses the specific sequence number, no
matter what the sequence increment is. Prev and Next subtract or add the
sequence increment to the current sequence number to get the sequence
number of the image to display.

3.3 Image display areas

dtdisplay has two image display areas, a large one on the right and a small one
in the lower left of the main window (see Figure 6 above). A few commands
work in both display areas, while other commands only work in the large display
area.

Left mouse button pressed down

If you press and hold the left mouse button down in an image display
area, the image pixel coordinates and pixel value are displayed in the upper left
or upper right of the display area. As you move the mouse pointer with the left
mouse button held down, the information is updated. This is the fastest way to
see pixel values. This works in both the large and small image display areas.

Left mouse button released

When you release the left mouse button in the large image display area,
this selects the pixel under the mouse pointer. Information about the pixel is
displayed in the scrolled text output area and usually includes pixel coordinate,
pixel value, resolution, etc. (see above). Furthermore, the small image display
area shows a zoomed region around the selected pixel.

Middle mouse button
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Use the middle mouse button to select a rectangle to zoom in on. When
you press and hold down the middle mouse button a rectangle appears that
indicates the area to be zoomed. Drag the mouse pointer to change the size of
the rectangle. Releasing the middle mouse button displays the zoomed area.
Double-clicking the middle mouse unzooms the image or refreshes an
unzoomed image. If the zoom box is within a single pixel, this also unzooms the
image. If you zoom large enough, the actual pixel values are displayed within
the pixels. The middle mouse button works in both the large and small image
display areas.

If you press and hold the left mouse button, while the zoom rectangle is active,
then this pans or moves the zoom rectangle around within the image. You may
release only the left mouse button to continue to change the size of zoom box.

NOTE: Make sure the CAPS LOCK, SHIFT and CTRL keys are not depressed or
you will be unable to drag out a zoom box.

FIRST left, then middle mouse button pressed down

If you press and hold the left mouse button down in an image display
area, then press and hold the middle mouse button down, you can pan around a
zoomed image by dragging the mouse around. This works best in the small
image area.

Right mouse button
The right mouse button currently has no function. Perhaps in the future it
will pop-up a menu.

Keyboard commands in the image areas

If the keyboard focus is in the large or small image area, then a few
keyboard commands can be used. One way to set the keyboard focus in the
small image area is to click on the Scan No. text field, then press the Tab key.
To set the keyboard focus to the large image area, select the scrolled text area,
then press Ctrl+Tab. Keyboard commands are:

> G, <, L
These zoom (>, G) or unzoom (<, L) the displayed image by a factor of 2.

I, J, K, M. arrow keys
These shift or pan the view. The shift is one-tenth of the viewed area or 1
pixel, whichever is larger.
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3.4 Examples

Below are figures that show a few examples of dtdisplay. Figure 7 was created
by the following sequence of commands:
File Open...
File Load refinlist...
Drag out a zoom box with middle mouse button in the large image area
Click on the small image area with the middle mouse button to unzoom it.

-

-
.
-
Lo

Figure 7. Large area zoomed view with reflect ion list plotted. Small area full view.
(Note: the partial crosses are an artefact of the word processor.)
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Figure 8 was made by the following sequence of commands:
File Open...
Drag out a zoom box with middle mouse button in the large image area
Drag out a zoom box again on the zoomed image to zoom even more.
Click on the peak with the left mouse button so the small image area
displays it.
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L1 Tl T Lok Lo e L G a3 T¥ L0 Lo L)
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Figure 8. Large area zoomed view with pixel values displayed. Small area zoomed view.

4. Overcoming difficulties

Difficulties with dtdisplay can be divided into problems with X Windows and
problems with dtdisplay itself.
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4.1 Problems with X Windows

If you cannot get the main window to appear at all, chances are the DISPLAY
environment variable or the permissions on the display are not set properly.
Consult you system manager for help on this.

If the main window appears, but the message “not enough colors” appears, then
you have a black and white display on which dtdisplay will not work. Move to a
color display and try again.

If the main window appears, but the image colors look funny and you experience
“color flashing”, then there is a problem with your X server. dtdisplay contains
algorithms to reduce color flashing, but some X servers or window managers
(e.g. Xsgi) do not install colormaps according to the X and Motif standards. To
work around this, you can exit from other programs that use a large number of
colors and restart dtdisplay.

If the main window appears, but all the buttons have funny names like cbFile,
then the application defaults file was not loaded properly. Be sure the
application defaults file Dtdisplay is in the proper directory such as /ust/lib/X11/app-
defaults or your home directory. Or use xrdb -merge Dtdisplay to explicit load the file,
then restart dtdisplay.

4.2 Problems with dtdisplay

Since dtdisplay gets almost all of its input information from an image header,
difficulties may arise when the header is incomplete. Be sure that the detector
spatial distortion information and non-uniformity information is correct and the
files exist in the current directory or the filenames in the header include the path
or directory.

The output of dtdisplay clearly shows when any files have not been read
properly. Select View Image header... command to display image header with
its source, goniometers, detector and rotation properties. If these are incorrect,
then the image header is incorrect and should be modified. In these cases, add
or correct the information (use dtheaderedit) and run dtdisplay again.

Many commands in dtdisplay have no effect if an image is not currently
displayed. If the image display areas are gray, then read in an image with the
Open... command in the File menu. If the scan information (File, Image
Template...) points to images of a different size than the currently displayed
image, then any new images read with any command that uses the scan
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information will be displayed in the size of the current image. To prevent this
problem, always read in at least one image from the scan with the File Open...
command before using the File New Overlay and File New Tile commands.

If you cannot drag out a zoom box with the middle mouse button, be sure the
CAPS LOCK or SHIFT buttons are not depressed.

5 Installation

dtdisplay has been written in C++ with the ICS BuilderXcessory program on a
Silicon Graphics Indigo running IRIX 4.0.5H or higher and Motif version 1.1 or
higher. We used the GNU g++ compiler and the GNU make utility. Source
code, makefiles, the application defaults file and the html files are necessary to
build dtdisplay. In order to provide a very high level of customization, dtdisplay
extensively uses X resources. For this reason the application defaults file is very
important and must be installed properly. The program uses class Dtdisplay, and
the application defaults file is also called Dtdisplay. This file should be placed in

your home directory or in the system-wide application defaults directory
{usr/lib/X11/app-defaults

To install dtdisplay from the sources, see 5.2 Make.

If you have the dtdisplay executable binary, then place it in a standard location in
your path (fusr/local/bin comes to mind).

Place the html files in a common area (/usr/local/lhtml comes to mind) where all
users have read permission.

Edit the application defaults file to reflect your customization (see 5.1 Application
defaults) and place it in your login directory or in the system application defaults
directory.

5.1 Application defaults file

All the titles, labels, fonts, error messages, help messages and colors used by
dtdisplay are specified in an application defaults file. This allows every site to
customize the appearance of dtdisplay. With a little bit of work, but without re-
compiling dtdisplay, the entire user interface can be changed to French or any
other language. Despite the apparent advantage of extensive customization, a
major disadvantage is that the application defaults file must exist and be



d*TREK dtdisplay Revision 01
Molecular Structure Corporation April 15, 1996
Document No. SBC01-????-00 Page 27 of 37

accessible to all who use dtdisplay. This section describes the defaults file and
helps you customize it.

dtdisplay defines the class Dtdisplay and hence the application defaults file is
called Didisplay. Below is the application defaults file as distributed.

1 I*

2 I* RCS stuff:

3 I'* $Author: jwp $

4 I* $Date: 96/04/01 11:27:45 $

5 I'* $Header: /u6/jwp/DTREKREPOSITORY/DTREK/DTREK/src/DTDISPLAY/Dtdisplay,v 1.4 96/04/01 11:27:45 jwp
Exp $

6 I* $Log: Dtdisplay,v $

7 IRevision 1.4 96/04/01 11:27:45 jwp

8 IChanges due to differences between servers: Motif 1.1 vs 1.2?

9 !

10 IRevision 1.2 95/11/08 17:38:48 jwp

11 IChange pushButton4.labelString.

12 !

13 # Revision 1.1 95/09/07 10:34:07 jwp

14 # Initial commit.

15 #

16 I* $Revision: 1.4 $

17 1%/

18 !

19 ! Generated by the ICS Builder Xcessory (BX).

20 !

21 ! Version = Builder Xcessory 3.5.1

22 !

23 *fontList: -*-helvetica-bold-r-*-*-18-*-*

24 *XmLabel.fontList: -*-helvetica-bold-r-*-*-18-*-*

25 *dalmageBig.resizable: ~ True

26 *dalmageSmall.resizable:  True

27 *frame.resizable: True

28 *frame.leftPosition: 52

29 *dalmageBig*font: -*-helvetica-bold-r-*-*-18-*-*

30 *dalmageBig*foreground: blue

31 *dalmageBig*Foreground: blue

32 *dalmageBig.translations: #override\n\

33 <Btn1Motion>: DrawingArealnput() ManagerGadgetButtonMotion() \n\
34 <Btn2Motion>: DrawingArealnput() ManagerGadgetButtonMotion() \n\
35 <BtnUp>:  DrawingArealnput() ManagerGadgetButtonMotion() \n\
36 <BtnDown>: DrawingArealnput() ManagerGadgetButtonMotion()

37 *dalmageSmall.translations: #override\n\

38 <Btn1Motion>: DrawingArealnput() ManagerGadgetButtonMotion() \n\
39 <Btn2Motion>: DrawingArealnput() ManagerGadgetButtonMotion() \n\
40 <BtnUp>:  DrawingArealnput() ManagerGadgetButtonMotion() \n\
41 <BtnDown>: DrawingArealnput() ManagerGadgetButtonMotion()

42 *keyboardFocusPolicy: explicit

43 *dalmageBig*traversalOn:  True

44 *helpLineHTMLHelp: Use NCSA mosaic to view html help files

45 I Mosaic Help default overrides:

46 *helpDirectory: /u6/jwp/DTREK/src/DTDISPLAY/
47 *htmlIFileOpen: FileOpen

48 *htmIHelpHTML: dtdisplay

49 *helpDelimiter: \ \ -- Help: \\
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50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69

70
71
72
73
74
75
76
77
78
79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106

*helpPrefix:
*pixelValueColor: blue
*refinPlotColor: blue

!
!

!

*dtdisplay.title: d*TREK - dtdisplay
*dtdisplay.iconName: dtdisplay
*dtdisplay*mbError.dialogTitle: d*TREK - Error dialog

*dtdisplay*mbError.messageString: This is an error message

*dtdisplay*mbError.cancelLabelString: Dismiss

*dtdisplay*mbProgress.dialogTitle: d*TREK display - Progress ...
*dtdisplay*mbProgress.messageString: Progress of overlaying images
*dtdisplay*fsbLoadRefIn.dialogTitle: d*Trek - display: File: Load reflection file
*dtdisplay*fmViewHeader.dialogTitle: d*TREK - Image header

*dtdisplay*pbViewHeaderDismiss.labelString: Dismiss
*dtdisplay*tfViewHeader.scrollLeftSide: True
*dtdisplay*xmDialogShell3.title: d*TREK - How to Zoom

*dtdisplay*mbViewZoomPan.dialogTitle: d*TREK - How to Zoom and Pan ...

*dtdisplay*mbViewZoomPan.messageString: :::t\"Select the image area to ZOOM\":t\"by dragging out a box in the
image\":t\"with the middle mouse button.\":\"\":t\"To UNZOOM an image, single click\":t\" on it with the middle mouse
button.\":\"\":t\"To PAN an image, press and hold the left mouse, \":t\"then press and hold the middle mouse button;

drag \"\"the mouse to pan.\"
*dtdisplay*pbFileNewlmage.labelString: Image file...
*dtdisplay*pbFileNewScan.labelString: Scan...
*dtdisplay*pbFileNewOverlay.labelString: Overlay...
*dtdisplay*pbFileNewTile.labelString: Tile...
*dtdisplay*pbFileNewUnderlay.labelString: Underlay...
*dtdisplay*pbFileNewAverage.labelString: Average...
*dtdisplay*pbFileNewStats.labelString: Statistics...
*dtdisplay*cbFileNew.labelString: New
*dtdisplay*pbFileOpen.labelString: Open...
*dtdisplay*pbFileLoad.labelString: Load refin list...
*dtdisplay*pbFileSaveAs.labelString: Save As...
*dtdisplay*pbFileTemplate.labelString: Image template...
*dtdisplay*pbFilePrefer.labelString: Preferences...
*dtdisplay*pbFilePrint.labelString: Print...
*dtdisplay*tbFileListen.labelString: Respond to updates
*dtdisplay*pbFileExit.labelString: Exit
*dtdisplay*cbFile.labelString: File
*dtdisplay*pbEditimage.labelString: Image view props...
*dtdisplay*pbEditRefln.labelString: Refln view props...
*dtdisplay*pbEditClear.labelString: Clear selected output
*dtdisplay*cbEdit.labelString: Edit
*dtdisplay*pbViewRefresh.labelString: Refresh
*dtdisplay*pbViewZoom.labelString: Zoom...
*dtdisplay*pbViewUnzoom.labelString: Unzoom
*dtdisplay*pbViewPan.labelString: Pan...
*dtdisplay*pbViewHeader.labelString: Image header...
*dtdisplay*tbViewCalc.labelString: Calculated reflns
*dtdisplay*tbViewObs.labelString: Observed refins
*dtdisplay*tbViewReso.labelString: Resolution arcs
*dtdisplay*tbViewMeasure.labelString: Measure
*dtdisplay*tbViewPlot.labelString: Plot points...
*dtdisplay*tbViewPixel.labelString: View pixel values...
*dtdisplay*cbView.labelString: View
*dtdisplay*pbOptionsPerspect.labelString: Perspective...
*dtdisplay*pbOptionsContour.labelString: Contour...
*dtdisplay*cbOptions.labelString: Options

*dtdisplay*pbHelpHTML.labelString: Help via HTML viewer...
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107
108
109
110
111
112
113
114
115
116
117
118
119
120

121
122
123

124
125
126
127
128
129
130
131

132
133
134
135
136
137
138
139
140
141

142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159
160
161
162

*dtdisplay*cbHelp.labelString: Help
*dtdisplay*dalmageSmall.background: grey95
*dtdisplay*IblmageNum.labelString: No:
*dtdisplay*pblmageNext.labelString: Next
*dtdisplay*pblmagePrev.labelString: Prev
*dtdisplay*lbWavelength.labelString: Wavelength:
*dtdisplay*tfOutput.value: This scrolled text area\n\
contains general intormation\n\

on selected user actions.
*dtdisplay*IbRotStart.labelString: Rot start:
*dtdisplay*IbRotEnd.labelString: Rot end:
*dtdisplay*IbDetDist.labelString: Det dist:
*dtdisplay*IbDetSwing.labelString: Det swing:
*dtdisplay*dalmageBig.background: grey95

I+t

! Builder Xcessory class defaults section
I+ +++

I++

I Defaults for class: CUIPSfileSelect

I--

CUIPSfileSelect.CUIPSfileSelect.dialogTitle: Select PostScript file name
CUIPSfileSelect. CUIPSfileSelect.selectionLabelString: PostScript file
CUIPSfileSelect. CUIPSfileSelect.okLabelString: OK

CUIPSfileSelect. CUIPSfileSelect. filterLabelString: Filter
CUIPSfileSelect.lbComment.labelString: Comment

I++

! Defaults for class: CUInumberField

I--

CUInumberField.CUInumberField.sensitive: True
CUInumberField.scrollBar.value: 1
CUInumberField.scrollBar.minimum: -500
CUInumberField.scrollBar.maximum: 611
CUInumberField.scrollBar.pagelncrement: 10
CUInumberField.textField.value: %.2f
CUInumberField.label.labelString: label

I++

! Defaults for class: CUlom8

I--

CUIloma8.pb0.sensitive: True
CUIloma8.pb0.labelString: Black
CUlom8.pbl.sensitive: True
CUIlom8.pb1l.labelString: Red
CUloma8.pb2.sensitive: True
CUIloma8.pb2.labelString: Orange
CUlom8.pb3.sensitive: True
CUIloma8.pb3.labelString: Yellow
CUlom8.pb4.sensitive: True
CUIloma8.pb4.labelString: Green
CUIloma8.pb5.sensitive: True
CUIloma8.pb5.labelString: Blue
CUIlom8.pb6.sensitive: True
CUIloma8.pb6.labelString: Magenta
CUlom8.pb7.sensitive: True
CUIlom8.pb7.labelString: Cyan
CUloma8.pb8.sensitive: True
CUIloma8.pb8.labelString: White
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163
164

165
166
167
168
169
170
171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187

188
189
190
191
192
193
194
195
196
197
198
199
200
201
202
203
204
205
206
207
208
209
210
211
212
213

214
215
216
217
218
219

CUIlom8.om9.sensitive: True
CUlom8.om9.labelString: Red

I++

! Defaults for class: CUlom2

I--

CUlom2.pb0.sensitive: True
CUlom2.pb0.labelString: Black
CUlom2.pbl.sensitive: True
CUlom2.pb1l.labelString: Red
CUlom2.pb2.sensitive: True
CUlom2.pb2.labelString: Orange
CUlom2.pb3.sensitive: True
CUlom2.pb3.labelString: Yellow
CUlom2.pb4.sensitive: True
CUlom2.pb4.labelString: Green
CUlom2.pb5.sensitive: True
CUlom2.pb5.labelString: Blue
CUlom2.pb6.sensitive: True
CUlom2.pb6.labelString: Magenta
CUlom2.pb7.sensitive: True
CUlom2.pb7.labelString: Cyan
CUlom2.pb8.sensitive: True
CUlom2.pb8.labelString: White
CUlom2.om9.sensitive: True
CUlom2.om9.labelString: Blue

I++

! Defaults for class: CUlom9

I--

CUIlom9.pb0.sensitive: True
CUIlom9.pb0.labelString: Black
CUlom9.pbl.sensitive: True
CUIlom9.pb1l.labelString: Red
CUlom9.pb2.sensitive: True
CUlom9.pb2.labelString: Orange
CUlom9.pb3.sensitive: True
CUIlom9.pb3.labelString: Yellow
CUlom9.pb4.sensitive: True
CUlom9.pb4.labelString: Green
CUlom9.pb5.sensitive: True
CUIlom9.pb5.labelString: Blue
CUIlom9.pb6.sensitive: True
CUIlom9.pb6.labelString: Magenta
CUlom9.pb7.sensitive: True
CUlom9.pb7.labelString: Cyan
CUIlom9.pb8.sensitive: True
CUlom9.pb8.labelString: White

CUIom9.om9.sensitive: True
T

! For some reason the class defaults are used, so be careful below!
T

CUlom9.om9.labelString: Red

I++

! Defaults for class: CUlimageviewprops

l--

CUlimageviewprops.CUlimageviewprops.dialogTitle: d*TREK - Edit image view properties
CUlimageviewprops.CUlimageviewprops.selectionLabelString: Command:
CUlimageviewprops.lbExpTimeO.labelString: ?
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220 CUIlimageviewprops.IbRotEndO.labelString: ?

221 CUlimageviewprops.lbRotStartO.labelString: ?

222 CUlimageviewprops.lbimgSizeO.labelString: ?

223 CUlimageviewprops.IbExpTime.labelString: Exposure time:
224 CUlimageviewprops.IbRotEnd.labelString: Rot end:

225 CUIlimageviewprops.IbRotStart.labelString: Rot start:

226 CUIlimageviewprops.tfReserve.value: Reserved

227 CUlimageviewprops.tfAspect.value: 1.0

228 CUlimageviewprops.omRescale.pbl.labelString: No
229 CUlimageviewprops.omRescale.pb0.labelString: Yes

230 CUlimageviewprops.omUseAspect.pbl.labelString: No
231 CUlimageviewprops.omUseAspect.pb0.labelString: Yes
232 CUlimageviewprops.omOrient.pb7.labelString: -Y -X
233 CUIlimageviewprops.omOrient.pb6.labelString: -Y +X
234 CUIlimageviewprops.omOrient.pb5.labelString: +Y -X
235 CUlimageviewprops.omOrient.pb4.labelString: +Y +X
236 CUlimageviewprops.omOrient.pb3.labelString: -X -Y
237 CUlimageviewprops.omOrient.pb2.labelString: -X +Y
238 CUIlimageviewprops.omOrient.pbl.labelString: +X -Y
239 CUlimageviewprops.omOrient.pb0.labelString: +X +Y

240 CUlimageviewprops.IbReserve.labelString: Reserved:

241 CUlimageviewprops.lbRescale.labelString: Auto rescale:

242 CUlimageviewprops.lbAspect.labelString: Pixel aspect ratio:

243 CUIlimageviewprops.lbUseAspect.labelString: Preserve aspect ratio:
244 CUlimageviewprops.lbOrient.labelString: Orientation:

245 CUlimageviewprops.tfBorder.value: 0.9

246 CUlimageviewprops.IbBorder.labelString: Image border fraction:
247 CUlimageviewprops.tfSatValue.value: 65355

248 CUlimageviewprops.IbSatColor.labelString: Saturated pixel color:
249 CUIlimageviewprops.IbSatValue.labelString: Saturated pixel cutoff:
250 CUIlimageviewprops.tfBoxSize.value: 25, 25

251 CUIlimageviewprops.IbBoxSize.labelString: Integration box size:

252 CUIlimageviewprops.IbBlackPix.labelString: Black pixel:
253 CUlimageviewprops.lbWhitePix.labelString: White pixel:
254 CUIlimageviewprops.tfBlackPix.value: 100

255 CUIlimageviewprops.tfWhitePix.value: 0

256 CUIlimageviewprops.lbMinMaxO.labelString: ?

257 CUIlimageviewprops.lbAvgSDO.labelString: ?

258 CUlimageviewprops.IbMinMax.labelString: Min, Max:
259 CUIlimageviewprops.IbAvgSD.labelString: Average, sd:

260 CUIlimageviewprops.IbimgSize.labelString: Image size:

261 I++

262 I Defaults for class: CUlimagefileSelect

263 I--

264 CUIlimagefileSelect.CUlimagefileSelect.dialogTitle: Select image file and/or template name
265 CUIlimagefileSelect.CUlimagefileSelect.selectionLabelString: Image file

266 CUIlimagefileSelect.CUlimagefileSelect.okLabelString: OK
267 CUIlimagefileSelect.CUlimagefileSelect.filterLabelString: Filter or Template

268 CUIlimagefileSelect.numimages.sensitive: True

269 CUlimagefileSelect.numimages.scrollBar.minimum: 0

270 CUIlimagefileSelect.numimages.scrollBar.maximum: 111

271 CUlimagefileSelect.numimages.textField.value: %.0f

272 CUlimagefileSelect.numimages.label.labelString: :::(\"Num\"\"images\"
273 CUIlimagefileSelect.seqIncr.sensitive: True

274 CUlimagefileSelect.seqlIncr.textField.value: %.0f

275 CUIlimagefileSelect.seqIncr.label.labelString: ::t\"Seqg\"\"incr\"

276 CUIlimagefileSelect.seqStart.sensitive: True

277 CUlimagefileSelect.seqStart.textField.value: %.0f
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278 CUIlimagefileSelect.seqStart.label.labelString: ::t\"Seq\"\"start\"
279 I++

280 | Defaults for class: CUIreflnviewprops

281 I--

282 CUIreflnviewprops.CUIreflnviewprops.dialogTitle: d*TREK - Edit reflection view properties
283 CUIreflnviewprops.lbRotRange.labelString: Rot range:

284 CUIreflnviewprops.IbRestrictRange.labelString: Restrict range:
285 CUIreflnviewprops.lbPredObs.labelString: Pred / Obsv:

286 CUIreflnviewprops.IbVisible.labelString: Visible:

287 CUIreflnviewprops.IbColor.labelString: Color:

288 CUIreflnviewprops.lbSymbol.labelString: Symbol:

289 CUIreflnviewprops.pushButton55.labelString: Yes

290 CUIreflnviewprops.pushButton56.labelString: No

291 CUIreflnviewprops.pushButton54.labelString: Predicted

292 CUIreflnviewprops.pushButton57.labelString: Observed

293 CUIreflnviewprops.pushButton60.labelString: Both

294 CUIreflnviewprops.pushButton53.labelString: Yes

295 CUIreflnviewprops.pushButton58.labelString: No

296 CUIreflnviewprops.pushButton52.background: black

297 CUIreflnviewprops.pushButton52.labelString: Black

298 CUIreflnviewprops.pushButton59.background: white

299 CUIreflnviewprops.pushButton59.labelString: White

300 CUIreflnviewprops.pushButton64.background: red

301 CUIreflnviewprops.pushButton64.labelString: Red

302 CUIreflnviewprops.pushButton65.background: orange

303 CUIreflnviewprops.pushButton65.labelString: Orange

304 CUIreflnviewprops.pushButton66.background: yellow

305 CUIreflnviewprops.pushButton66.labelString: Yellow

306 CUIreflnviewprops.pushButton67.background: green

307 CUIreflnviewprops.pushButton67.labelString: Green

308 CUIreflnviewprops.pushButton68.background: blue

309 CUIreflnviewprops.pushButton68.labelString: Blue

310 CUIreflnviewprops.pushButton69.labelString: Cyan

311 CUIreflnviewprops.pushButton70.labelString: Magenta

312 CUIreflnviewprops.IbSize.labelString: Size:

313 CUIreflnviewprops.pushButton21.labelString: + sign

314 CUIreflnviewprops.pushButton22.labelString: x sign

315 CUIreflnviewprops.pushButton50.labelString: o sign

316 CUIreflnviewprops.pushButton51.labelString: [] box

317 CUIreflnviewprops.lbReflnName.labelString: Reflection list:
318 I++++++++++++++++

319 ! Builder Xcessory class defaults section

320 I++++++++++++++++

321 I++

322 I Defaults for class: CUIPSfileSelect

323 I--

324 CUIPSfileSelect.CUIPSfileSelect.dialogTitle: d*TREK - Select PostScript file name
325 CUIPSfileSelect.CUIPSfileSelect.selectionLabelString: PostScript file
326 CUIPSfileSelect.CUIPSfileSelect.okLabelString: OK

327 CUIPSfileSelect.CUIPSfileSelect filterLabelString: Filter

328 CUIPSfileSelect*lbComment.labelString: Comment

329 ++

330 I Exposed resources for class instances

331 I--

332 *cUlimageviewprops.dialogTitle: d*TREK - Edit image view properties
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333
334
335
336
337
338
339
340
341
342
343
344
345
346
347
348
349
350
351
352
353
354
355
356
357
358
359
360
361
362
363
364
365
366
367
368
369
370
371
372
373

374
375
376
377
378
379

380
381
382
383
384
385
386
387
388
389

*cUlimageviewprops*IbExpTimeO.labelString: ?
*cUlimageviewprops*IbRotEndO.labelString: ?
*cUlimageviewprops*lbRotStartO.labelString: ?
*cUlimageviewprops*lbimgSizeO.labelString: ?
*cUlimageviewprops*IbExpTime.labelString: Exposure time:
*cUlimageviewprops*IbRotEnd.labelString: Rot end:
*cUlimageviewprops*lbRotStart.labelString: Rot start:
*cUlimageviewprops*tfBlackPix.value: 100
*cUlimageviewprops*tfWhitePix.value: 0
*cUlimageviewprops*tfSatValue.value: 65535.0
*cUlimageviewprops*tfBoxSize.value: 25, 25
*cUlimageviewprops*tfReserve.value: Reserved
*cUlimageviewprops*tfAspect.value: 1.0
*cUlimageviewprops*tfBorder.value: 0.9
*cUlimageviewprops*omColor*pb8.labelString: White
*cUlimageviewprops*omColor*pb8.background: white
*cUlimageviewprops*omColor*pb8.helpLine: Saturated pixels will be WHITE
*cUlimageviewprops*omColor*pb7.labelString: Cyan
*cUlimageviewprops*omColor*pb7.background: cyan
*cUlimageviewprops*omColor*pb7.helpLine: Saturated pixels will be CYAN
*cUlimageviewprops*omColor*pb6.labelString: Magenta
*cUlimageviewprops*omColor*pb6.background: magenta
*cUlimageviewprops*omColor*pb6.helpLine: Saturated pixels will be MAGENTA
*cUlimageviewprops*omColor*pb5.labelString: Blue
*cUlimageviewprops*omColor*pb5.background: blue
*cUlimageviewprops*omColor*pb5.helpLine: Saturated pixels will be BLUE
*cUlimageviewprops*omColor*pb4.labelString: Green
*cUlimageviewprops*omColor*pb4.background: green
*cUlimageviewprops*omColor*pb4.helpLine: Saturated pixels will be GREEN
*cUlimageviewprops*omColor*pb3.labelString: Yellow
*cUlimageviewprops*omColor*pb3.background: yellow
*cUlimageviewprops*omColor*pb3.helpLine: Saturated pixels will be YELLOW
*cUlimageviewprops*omColor*pb2.labelString: Orange
*cUlimageviewprops*omColor*pb2.background: orange
*cUlimageviewprops*omColor*pb2.helpLine: Saturated pixels will be ORANGE
*cUlimageviewprops*omColor*pbl.labelString: Red
*cUlimageviewprops*omColor*pbl.background: red
*cUlimageviewprops*omColor*pbl.helpLine: Saturated pixels will be RED
*cUlimageviewprops*omColor*pb0.labelString: Black
*cUlimageviewprops*omColor*pb0.background: black
*cUlimageviewprops*omColor*pb0.helpLine: Saturated pixels will be BLACK

! For some reason the class defaults are used, so be careful below!
T

CUlom9.om9.labelString: Red
I Careful here: sometimes works, sometimes does not depending on server!?:
*cUlimageviewprops*omColor*labelString: Red

*cUlimageviewprops*omRescale*pb1l.labelString: No
*cUlimageviewprops*omRescale*pbl.helpLine: Not implemented
*cUlimageviewprops*omRescale*pb0.labelString: Yes
*cUlimageviewprops*omRescale*pb0.helpLine: Not implemented
*cUlimageviewprops*omUseAspect*pbl.labelString: No
*cUlimageviewprops*omUseAspect*pbl.helpLine: Do NOT preserve the pixel aspect ratio
*cUlimageviewprops*omUseAspect*pb0.labelString: Yes
*cUlimageviewprops*omUseAspect*pb0.helpLine: Preserve the pixel aspect ratio
*cUlimageviewprops*omOrient*pb7.labelString: -Y -X
*cUlimageviewprops*omOrient*pb7.helpLine:  Origin in lower right, Y left, X up
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390 *cUlimageviewprops*omOrient*pb6.labelString: -Y +X

391 *cUlimageviewprops*omOrient*pb6.helpLine:  Origin in upper right, Y left, X down
392 *cUlimageviewprops*omOrient*pb5.labelString: +Y -X

393 *cUlimageviewprops*omOrient*pb5.helpLine:  Origin in lower left, Y right, X up
394 *cUlimageviewprops*omOrient*pb4.labelString: +Y +X

395 *cUlimageviewprops*omOrient*pb4.helpLine:  Origin in upper left, Y right, X down
396 *cUlimageviewprops*omOrient*pb3.labelString: -X -Y

397 *cUlimageviewprops*omOrient*pb3.helpLine:  Origin in lower right, X left, Y up
398 *cUlimageviewprops*omOrient*pb2.labelString: -X +Y

399 *cUlimageviewprops*omOrient*pb2.helpLine:  Origin in upper right, X left, Y down
400 *cUlimageviewprops*omOrient*pbl.labelString: +X -Y

401 *cUlimageviewprops*omOrient*pbl.helpLine:  Origin in lower left, X right, Y up
402 *cUlimageviewprops*omOrient*pb0.labelString: +X +Y

403 *cUlimageviewprops*omOrient*pb0.helpLine:  Origin in upper left, X right, Y down

404 mmn

405 ! For some reason the class defaults are used, so be careful below!
406 mmn

407 CUlom8.om9.labelString: -X -Y

408 I Careful here: sometimes works, sometimes does not depending on server!?:
409 *cUlimageviewprops*omOrient*labelString: -X -Y

410 mmn

411 ! For some reason the class defaults are used, so be careful below!
412 mm

413 CUlom2.om9.labelString: No

414 I Careful here: sometimes works, sometimes does not depending on server!?:
415 *cUlimageviewprops*omUseAspect*labelString: No

416 *cUlimageviewprops*IbSatColor.labelString: Saturated pixel color:
417 *cUlimageviewprops*lbSatValue.labelString: Saturated pixel cutoff:
418 *cUlimageviewprops*IbBoxSize.labelString: Integration box size:

419 *cUlimageviewprops*IbReserve.labelString: Reserved:

420 *cUlimageviewprops*IbRescale.labelString: Auto rescale:

421 *cUlimageviewprops*lbAspect.labelString: Pixel aspect ratio:

422 *cUlimageviewprops*lbUseAspect.labelString: Preserve aspect ratio:
423 *cUlimageviewprops*IbOrient.labelString: Orientation:

424 *cUlimageviewprops*lbBlackPix.labelString: Black pixel in image:

425 *cUlimageviewprops*IbWhitePix.labelString: White pixel in image:
426 *cUlimageviewprops*IbMinMaxO.labelString: ?

427 *cUlimageviewprops*IbAvgSDO.labelString: ?

428 *cUlimageviewprops*IbMinMax.labelString: Min, Max:

429 *cUlimageviewprops*IbAvgSD.labelString: Average, sd:

430 *cUlimageviewprops*IbimgSize.labelString: Image size:

431 *cUlimageviewprops*IbBorder.labelString: Image border fraction:

432 *cUIreflnviewprops*dialogTitle: d*TREK - Edit reflection view properties
433 *cUIreflnviewprops*IbRotRange.labelString: Rot range:

434 *cUlreflnviewprops*lbRestrictRange.labelString: Restrict range:
435 *cUlreflnviewprops*lbPredObs.labelString: Pred / Obsv:

436 *cUlreflnviewprops*lbVisible.labelString: Visible:

437 *cUlreflnviewprops*lbColor.labelString: Color:

438 *cUIreflnviewprops*lbSymbol.labelString: Symbol:

439 *cUIreflnviewprops*pushButton55.labelString: Yes

440 *cUlreflnviewprops*pushButton56.labelString: No

441 *cUlIreflnviewprops*pushButton54.labelString: Predicted

442 *cUlIreflnviewprops*pushButton57.labelString: Observed

443 *cUlreflnviewprops*pushButton60.labelString: Both

444 *cUIreflnviewprops*pushButton53.labelString: Yes
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445 *cUlreflnviewprops*pushButton58.labelString: No
446 *cUlreflnviewprops*pushButton52.background: black
447 *cUlIreflnviewprops*pushButton52.labelString: Black
448 *cUlreflnviewprops*pushButton59.background: white
449 *cUIreflnviewprops*pushButton59.labelString: White
450 *cUlreflnviewprops*pushButton64.background: red
451 *cUIreflnviewprops*pushButton64.labelString: Red

452 *cUlreflnviewprops*pushButton65.background: orange
453 *cUlreflnviewprops*pushButton65.labelString: Orange
454 *cUIreflnviewprops*pushButton66.background: yellow
455 *cUIreflnviewprops*pushButton66.labelString: Yellow
456 *cUlreflnviewprops*pushButton67.background: green
457 *cUlreflnviewprops*pushButton67.labelString: Green

458 *cUlreflnviewprops*pushButton68.background: blue

459 *cUlreflnviewprops*pushButton68.labelString: Blue

460 *cUlreflnviewprops*pushButton69.labelString: Cyan

461 *cUlreflnviewprops*pushButton70.labelString: Magenta
462 *cUIreflnviewprops*IbSize.labelString: Size:

463 *cUlreflnviewprops*pushButton21.labelString: + sign

464 *cUlreflnviewprops*pushButton22.labelString: x sign

465 *cUlreflnviewprops*pushButton50.labelString: o sign

466 *cUlreflnviewprops*pushButton51.labelString: [ box

467 *cUIreflnviewprops*lbReflnName.labelString: Reflection list:
468 !

469 !

470 *cUIPSfileSelect.dialogTitle: d*TREK - Select PostScript file name
471 *cUIPSfileSelect.selectionLabelString: PostScript file

472 *cUIPSfileSelect*lbComment.labelString: Comment

473 !

474 !

475 *cUlimagefileSelect*dialogTitle: Select image file and/or template name
476 *cUlimagefileSelect*selectionLabelString: Image file

477 *cUlimagefileSelect*okLabelString: OK

478 *cUlimagefileSelect*filterLabelString: Filter or Template

479 *cUlimagefileSelect*numimages.sensitive: True

480 *cUlimagefileSelect*numimages.scrollBar.minimum: 0

481 *cUlimagefileSelect*numimages.scrollBar.maximum: 111

482 *cUlimagefileSelect*numimages.textField.value: %.0f

483 *cUlimagefileSelect*numimages.label.labelString: ::t\"Num\"\"images\"
484 *cUlimagefileSelect*seqincr.sensitive: True

485 *cUlimagefileSelect*seqincr.textField.value: %.0f

486 *cUlimagefileSelect*seqincr.label.labelString: ::t\"Seq\"\"incr\"

487 *cUlimagefileSelect*seqStart.sensitive: True

488 *cUlimagefileSelect*seqStart.textField.value: %.0f

489 *cUlimagefileSelect*seqStart.label.labelString: ::t\"Seq\"\"start\"

490 I *cUlimagefileSelect*helpHTML: FileTemplate
491 *htmicUlimagefileSelect: FileTemplate

In addition to the above resources, the following resources are also used. They
are divided into a few broad categories: help configuration, html filenames,
context-sensitive help lines, and error messages.

Help configuration
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dtdisplay tries to have a fully user-configurable help facility. This is
achieved by the following resources.

Resource Default value Notes

helpHTMLviewer mosaic Command to run the html viewer

helpDirectory ./ Directory for the html files

helpPrefix o Prefix to the html files

helpSuffix html Suffix to the html files

helpDelimiter “ --Help: *  Text placed between title and added help line
helpTmpDirectory tmp/ Temporary directory for mosaic control

The hyper-text markup language (html) viewer is a program external to dtdisplay
such as NCSA mosaic. The default values used by the help facility can be
changed by adding these resources to the application defaults file. dtdisplay
runs the viewer in response to the user activating a help command. The actual
html files are specified by an abbreviation with dtdisplay. The full html flenames
are constructed from concatenating the translations of the helpDirectory, helpPrefix,
the abbreviation and the helpSuffix together. Furthermore, the abbreviation can
be changed through the use of a resource of the same name with the string html
preprended. For example, if the abbreviation is FileTemplate (hard coded in the
source code), then the help facility checks if the resource htmiFileTemplate iS
defined and if so, translates it to get the file basename. The name of the html
file would be ./FileTemplate.ntml. If helpPrefix was changed to dtdisplay/ and the
helpDirectory was changed to /usr/local/html then the file would be
lusr/local/html/dtdisplay/FileTemplate.html. The installer of dtdisplay is responsible for
putting the html files in a public location and changing the resource file to reflect
this. dtdisplay defines the following resources for each of the Help buttons in the
program:

htmlFileTemplate
htmlEditRefInView
htmIDloadRefln
htmlViewZoom
htmlEditimageView
htmlFileOpen
htmlHelpHTML
htmlFilelmageTemplate
htmlFileNewOverlay
htmIFileNewTile

The context-sensitive help line displayed in the window title may be overridden
with the helpLine resource for push button, cascade button, toggle button, option
menu, and text field widgets. The helpLine resource specifies a text string that
will be placed in the main window title whenever a button is armed, menu is
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mapped or (in Motif 1.2) a text field gains keyboard focus. There are default
help lines in the dtdisplay program, but you can override them with a line such
as:

*dtdisplay*pbFileTemplate.helpLine: Pop-up the image template dialog

Error messages can also be overridden with through resources. The following
are error message resources:

errorFileNewOverlay

Two colors are specified through resources. The first is the color of the text
used for the pixel values when an image area is zoomed very large. The second
is for the color of the plotted reflection list (until the Edit refln props dialog is
implemented). The default values are shown next.

pixelValueColor: blue
reflnPlotColor: red

Not every color is supported for the above resources. Currently, the allowed
values are red, orange, yellow, green, blue, magenta, cyan, black and white.

5.2 Make

Source files for dtdisplay reside in two directories ../DTREK/src/DTDISPLAY and
...IDTREK/src/DTTREK. Use the makefiles specific for your platform. The makefiles
are called Makefile.platform, where platform describes succinctly the operating
system (e.g. sgi4, or hp). Copy the one for your system to Makefile in each
directory named below. Make the object library libdtrek.a from source files found
in the DTTREK directory:

cd .../DTREK/src/DTTREK
gmake lib

then change directory to .../DTREK/src/DTDISPLAY and type gmake:

cd ../DTDISPLAY
gmake
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Appendix

This appendix contains definitions for image and scan as used by d*TREK and

Image

Rotation

angle

dtdisplay.

An image is the output of a position-sensitive detector. It has a
header that describes the image and how it was made. dtdisplay
reads image headers to get information about images, so that
users do not need to describe the image to the program.

A rotation describes the goniometer movement while an image is
exposed. It has the following properties:

Rotation axis

The 3D vectorial representation of the rotation axis in
world coordinates when the crystal goniometer is at
the datum position. The axis goes from the crystal
position (0,0,0) in the axis direction such that a right-
hand rotation is the positive direction. For example, if
the omega axis points along X, then Rotation axis is
(2, 0, 0). General rotation axes may be easily
specified this way. In addition, the crystal goniometer
datum position specifies a rotation angle of 0 around
this axis.

Start angle The angle of the rotation axis at the start of exposure
End angle  The angle of the rotation axis at the end of exposure

Increment The difference between the Start angle and End

Time The exposure time in seconds of the image

Oscillations The number of times the axis oscillated from the Start

angle to the End angle back to the Start angle. A
simple rotation will have Oscillations equal to O.
Dark The number of dark images collected before the start

of the rotation and used for non-uniformity correction.
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Scan

DarkUpdate The dark image update interval. After this number of
images, a new dark image should be made.

DarkLimit ~ The dark image change limit. If the dark current
changes by more than this fraction, then a new dark
image should be collected.

DCoffset The number of DC offset images collected before the
start of the rotation and used for non-uniformity
correction.

DC Update The DC offset image update interval. After this
number of images, a new DC offset image should
be made. This should probably always be 0.

A scan is a set of contiguous (in rotation angle) images with similar
properties. The images are generated by a single detector so they
have the same dimensions, exposure time, angular increment and
non-uniformity of response. A scan has the same global properties
as described for Rotation, but the Scan End Angle is the end angle
of the last image in the scan. Other Scan properties which are not
pertinent to dtdisplay are described in the dtfind documentation.



